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1 - Ciclo de Desarrollo 
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Verif. Conexiones 
(Timbrado) 

Idea del Programa 

Declaración de  
Especificaciones 

Diagrama de Bloques 

Pinout y Esquemático 
de la Placa 

Desarrollo de un 
Prototipo 

Verif. Funcional 

Desarrollo Placa C.I. 
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Verif. Sintaxis 
(Compilador) 

Idea del Programa 

Declaración de  
Especificaciones 

Estructura y Diseño 

Escritura de los 
Programas 

Generación 
(Linker) 

Simulación en PC 

Depuración en Micro 

Grabación del Micro 
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2 - Diagramas de Flujo 
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• Son representaciones del funcionamiento de un programa 
o De forma genérica – independiente de la arquitectura 

 Nunca pueden contener referencias a registros de la arquitectura 
utilizada, ni a instrucciones de la CPU 

o Que muestran la solución al problema planteado 

o Que tienen que servir de guía, tanto al programador como a los 
posibles programadores que tengan que tocar ese programa 

• Se pueden escribir a distintos niveles de detalle/abstracción 
o El nivel de detalle que debe ser utilizado dependerá de la situación 

• Tradicionalmente se utilizarán sólo los símbolos sencillos: 
o Elipse o círculo, para indicar una etiqueta 

o Rectángulo, para indicar un proceso 

o Rombo, para indicar una decisión 
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Programa que espera 2 segundos para encender un LED en la salida digital PA1 del micro y 
luego la deja encendida para siempre  

¿Contador = 2 sg? 

Enciendo 
la salida 1 

SI 

NO 

Inicializo 
registros 

necesarios, 
el contador y 
apago el LED 

Inicio de 

programa 

Fin de 

programa 
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3 - La placa de Desarrollo STM32L-DISCOVERY 
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• La placa de desarrollo tiene las siguientes 
funcionalidades: 

o Microcontrolador STM32L152RB 

o Interfaz de depuración ST-LINK/V2 incluido 
(conectado al ordenador a través de Mini-USB) 

o Una pantalla LCD de 24 segmentos y 4 
comunes, o sea, 6 dígitos 

o 4 LEDs 

 2 de ellos programables por el usuario 
(LED_VERDE, LED AZUL) 

o Un sensor táctil lineal, con posibilidad de ser 
utilizado como 4 teclas individuales 

o Botón programable por el usuario (USER) 

o 2 Puertos de expansión a placa adicional (P1 y 
P2) 
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LED 
VERDE 

LED 
AZUL 
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PB6 

PB7 

PA0 

Alimentación a través del USB 

PUERTO P1: 
 
04 – PC13 
15 – PA0 
 ADC_IN0 
 TIM2_CH1_ETR 
19 – PA4 
 ADC_IN4 
 DAC_OUT1 
20 – PA5 
 SPI1_SCK 
 ADC_IN5 
 DAC_OUT2 
 TIM2_CH1_ETR 

PUERTO P2: 
 
07 – PB7 
 I2C1_SDA 
 TIM4_CH2 
 USART1_RX  
08 – PB6 
 I2C1_SCL 
 TIM4_CH1 
 USART1_TX 
12 – PD2 
 TIM3_ETR 
13 – PC12 
19 – PA12 
 USBDP 
 SPI1_MOSI 
20 – PA11 
 USBDM 
 SPI1_MISO 
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• Durante el curso, se va a permitir el préstamo personal 
de: 

o La Placa de Desarrollo STM32L-Discovery 

• El préstamo se hace con la condición de que el material 
se devuelva antes del examen en perfecto estado 

o De no ser así, los alumnos implicados no serán evaluados en la 
asignatura 

• Para obtener el material: 
o Imprimir, rellenar y firmar DOS copias del formulario de 

préstamo del material. El formulario se encuentra en Aula 
Global. 

o Entregar al coordinador de la asignatura el formulario, para 
que lo firme y se quede con una copia. 

o Acercarse al despacho 1.1.I.04 o 1.1.I.03 para entregar la 
autorización firmada por el profesor, y recoger el material. 

• El material se devolverá en los mismos despachos, 
entregándolo con el formulario de devolución ANTES DEL 
EXAMEN FINAL 
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• Para poder utilizar mucho mejor la placa STM32L1-Discovery, es 
aconsejable: 
o Pincharla en una protoboard (o en un conjunto de ellas), de forma que los 

pines no se cortocircuiten y además dejen huecos para conectar cables 

o Meter el conjunto de la protoboard, la placa, así como las conexiones 
realizadas, en una caja, para su transporte sin que se suelten las conexiones 

• En la siguiente transparencia se puede ver el detalle de conexión, 
así como un ejemplo de uso 
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4 - Instalación de Keil uVision 5 
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• El programa de instalación se puede descargar: 
o Directamente de la página de Keil (https://www.keil.com/arm/demo/eval/arm.htm) rellenando el formulario 

y descargando en MDK 
o Desde Aula Global , donde se encuentra el programa comprimido en varios ficheros .rar, que una vez 

descomprimidos, generan un fichero .exe que es el programa de instalación. 

• Ejecutando el mdk526.exe (o equivalente, ya que los números pueden cambiar, al cambiar la 
versión) se arranca el instalador del µVision : 

o Es preferible instalar el programa con la placa ya conectada, para que así se instale el driver de la placa 
 Si no se hace así, se puede instalar posteriormente el driver 

o De a todas las pantallas sobre Next, introduciendo la información solicitada 
 Si no sabe que poner en alguna opción, déjela en su valor por defecto. 

o Al finalizar la instalación del µVision, se solicitará la instalación de los drivers tipo ULINK, ST-Link, etc. 
 Aceptar todo el proceso 

• En algunos ordenadores o cuando se haya instalado el µVision sin tener la placa conectada, hay 
que instalar a mano el driver. Para ello: 

o Vaya a la página http://www.st.com/internet/evalboard/product/251168.jsp y pulse en la pestaña “Design 
Support”. (el fichero está también disponible en Aula Global) 

o Seleccione para descargar el “ST-LINK/V2 USB driver for Windows” 
o Descárguelo, descomprímalo y ejecútelo aceptando todas las opciones (incluso las preguntas de seguridad 

que impone el Windows) 
o Si sigue dando problemas, desenchufe el cable USB, espere unos segundos, y vuelva a enchufarlo.  

 Pruebe en distintos puertos USB 
 Si tenía una instalación anterior que no funcionaba, tendrá que ir, con la placa conectada, al Administrador de 

Dispositivos, y borrar el controlador que da fallos (el que salga con un símbolo de exclamación). 
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• Ejecuta el programa de instalación (mdk526.exe o similar). 
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• Acepta las condiciones de la licencia. 
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• Selecciona el lugar para la instalación o acepta la ubicación por 
defecto. 
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• Introduce tus datos (da igual lo que pongas, sobre todo en el e-
mail). 
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• Espera a que se instale la aplicación. 
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• Una vez finalizada la instalación puede solicitar ver las Release 
Notes y usar (o no) la configuración anterior (si se tenía ya una 
versión anterior instalada). Déjalo normalmente como se muestra 
en la imagen. 
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• Una vez instalado el uVision, se solicitará que instales los paquetes 
necesarios. 
o uVision es una plataforma de desarrollo que contempla multitud de 

procesadores, por lo que instalar todo puede ser excesivo. 
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• Permite (bastante) tiempo para que la herramienta localice todos 
los módulos disponibles a través de la red. 
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• Espera a que todos los “software pack descriptions” se hayan 
instalado (tarda algo de tiempo). 
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• En el árbol de la izquierda pulsa en la carpeta “ARM” y ahora en la 
derecha sobre “Update”, en donde te permita esa opción (símbolos 
en amarillo), hasta que se ponga en verde. 
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• Una vez finalizado, en el árbol de la izquierda, busca el 
“STM32L152RB” dentro de la carpeta “STMicroelectronics” y 
pincha en el enlace web que hay al lado. 
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• En la página web, pincha en “Download” del Device Family Pack (o 
coge el fichero del cargado en Aula Global). 
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• Una vez descargado, importa el Paquete en el Pack Installer (opción 
“File -> Import”). 
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• Es recomendable copiar a una carpeta local el ejemplo Blinky 
(STML32-Discvery), pulsando en el botón “Copy” en la pestaña de 
“Examples”. 
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• Una vez copiado, puedes probar el proyecto ejemplo en el entorno 
para comprobar que todo ha ido correctamente. 
o Se arranca el ejemplo Blinky en uVision, se compila y carga en la placa. Si 

todo va bien, al simular parpadean los LED azul y verde integrados en la 
placa. La forma de hacer todo esto se explica en las siguientes 
transparencias con la explicación del trabajo con el entorno. 
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5 - Instalación de STM32 CubeMX 
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• El programa de instalación se puede descargar: 
o Directamente de la página de ST (https://www.st.com/en/development-

tools/stm32cubemx.html) 

o Desde Aula Global , donde se encuentra el programa comprimido en 
ficheros .rar, que una vez descomprimidos, generan un fichero .exe que es el 
programa de instalación. 

• Ejecutando el fichero SetupSTM32CubeMX-5.0.1.exe (o 
equivalente, ya que los números pueden cambiar, al cambiar la 
versión) se arranca el instalador: 
o En algunas versiones de Windows, no reconoce el autor de este programa e 

intenta impedir su instalación 
 Hay que darle a Más Información y luego elegir la opción “Ejecutar de todas 

formas” 
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• Ejecuta el programa de instalación (SetupSTM32CubeMX-5.0.1.exe 
o similar). 
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• Acepta las condiciones. 
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• Acepta la política de privacidad. 

• Si lo deseas, puede aceptar que ST pueda usar información sobre cómo 
se usa la herramienta, para su mejora. 
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• Elije la ruta de instalación o deja la que hay por defecto. 
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• Configura los detalles de cómo se integrará en el entorno Windows. 
Deja normalmente lo que ves en la imagen. 
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• Espera a que acabe la instalación. 
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• Una vez finalizada, pulsa en “Next”. 

(C) Raúl Sánchez Reíllo SDBM - Tema 5: Entorno de Desarrollo 43 

CLASES PARTICULARES, TUTORÍAS TÉCNICAS ONLINE
LLAMA O ENVÍA WHATSAPP: 689 45 44 70

- - -
ONLINE PRIVATE LESSONS FOR SCIENCE STUDENTS
CALL OR WHATSAPP:689 45 44 70

www.cartagena99.com no se hace responsable de la información contenida en el presente documento en virtud al
Artículo 17.1 de la Ley de Servicios de la Sociedad de la Información y de Comercio Electrónico, de 11 de julio de 2002.
Si la información contenida en el documento es ilícita o lesiona bienes o derechos de un tercero háganoslo saber y será retirada.



http://dte.uc3m.es 

• Finalmente pulsa en “Done”. 
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6 - Primera Ejecución del STM32 CubeMX 
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• Para finalizar la instalación, es necesario que se inicie la aplicación 
una primera vez para que se actualicen sus componentes y sus 
bases de datos. 

• Al arrancar la primera vez, preguntará para que decidas si quieres o 
no que ST use estadísticas de uso de la aplicación 
o Elije la opción que desees. 
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• Permite la conexión a red para, por lo menos, cargar actualizaciones. 
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• Acepta la configuración de red o modifícala atendiendo a tus 
necesidades. Normalmente hay que dejar lo que ves en la imagen. 

• Puedes pulsar sobre el botón “Check” para comprobar que tienes 
conexión de Internet con la configuración elegida.  
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• En la pantalla principal, selecciona “Check for Updates”. 
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• Pulsa sobre “Refresh”. Si tiene actualizaciones pendientes se 
mostrarán en la ventana. Si es así, pulsa sobre “Install Now” para 
instalarlas.  
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• Cuando ya no queden actualizaciones por cargar y actualizar, o no 
haya salido ninguna desde el principio, pulsa sobre “Close”. 
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• Selecciona ahora “Start my Project from STBoards” o “….from MCU”. 
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• Espera a que cargue el listado entero de dispositivos y/o placas de 
Desarrollo. 
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• Una vez descargado el listado aparecerá la siguiente pantalla: 
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• Selecciona en el menú de filtrado de la izquierda lo siguiente: 
Vendor = STMicroelectronics, Type = Discovery, MCU Series = 
STM32L1. 
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• Del listado de placas resultante, pulsa sobre la última “STM32L-
Discovery”, y a continuación pulsa sobre el botón “Start Project”. 
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• Por motivos docentes, selecciona “Yes” a la pregunta sobre 
“Inicializar los periféricos en el Modo por defecto” 
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• Finalmente aparecerá la siguiente pantalla, en la cual ya se puede 
empezar a trabajar. De momento lo dejamos aquí. 
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• Una vez que hayas llegado a ver la pantalla anterior, ya se puede empezar 
a configurar las funcionalidades del microcontrolador y de la placa que le 
interesen para el proyecto. 

• Antes de hacer esto, tendrás que haber determinado previamente: 
o Qué periféricos vas a utilizar 

o Qué pines vas a usar y con qué funcionalidad 

o Qué configuración vas a querer utilizar para cada uno de esos pines y periféricos 

• Los pasos a trabajar con el Cube MX son los siguientes: 
1. Configurar los pines y periféricos 

2. Seleccionar el reloj del microcontrolador 

3. Gestionar el proyecto 

4. Pulsar “GENERATE CODE” y una vez finalizado, pulsar “Open Project” para 
abrir el Keil uVision con el proyecto. 

• Todo esto se verá en las siguientes transparencias mediante un ejemplo 
o Pero primero echemos un vistazo a las dos pantallas principales del CubeMX. 
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• La pestaña de configuración de pines y periféricos se puede dividir 
en 3 zonas. Más adelante en el curso se explicará en más detalle. 
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Vista de los detalles del 
periférico seleccionado en el 

árbol 

Vista del chip para configurar 
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• La pestaña de configuración hay que dejarla, de momento, como 
en la figura, para tener reloj de 32MHz partiendo del HSI. 
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7 - Creación de la Estructura Básica de Trabajo 
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• A lo largo del curso se van a hacer múltiples ejercicios, tanto de clase como de 
Laboratorio. 

• Cada uno de esos ejercicios será un Proyecto distinto. 

• Por tanto, es preferible crear una estructura básica de trabajo, para así tenerlo 
todo ordenado. 

• Crea en el disco duro de tu ordenador una carpeta para la asignatura (por 
ejemplo, D:\SDBM\). 
o Se recomienda que NO se utilice el escritorio, ya que las rutas son mucho más largas y 

muchas veces con caracteres complejos (por ejemplo, espacios). 

• Descarga de Aula Global el fichero “STM32L152C-Discovery.rar” (es decir, la 
biblioteca de la placa Discovery) y descomprímelo dentro de la carpeta de la 
asignatura. 
o Debería crear en la carpeta de la asignatura una subcarpeta con nombre STM32L152C-

Discovery, y dentro de esa subcarpeta debe haber 6 ficheros (entre ellos 2 .c y 2 .h). 
o Esa es la librería de alto nivel de uso del LCD. 

• A partir de aquí, sigue con el proyecto que has dejado en la transparencia 55 y 
ejecuta los pasos de generación de proyecto que se indican a continuación. 
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8 - Pasos para la creación de un proyecto 
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• Hagámoslo de forma práctica, a través de un ejemplo (aprovechando 
todo lo que ya has creado hasta la transparencia 55): 
o El programa irá sacando mensajes en el LCD secuencialmente, con un tiempo 

de espera apreciable (por ejemplo, 1 segundo), entre paso y paso: 
 Paso 1: 

─ LCD = “UNO” 

 Paso 2: 

─ LCD = “DOS” 

 Paso 3: 

─ LCD = “TRES” 

 Paso 4: 

─ LCD = “MAMBO” 

• Antes de ponerse a trabajar, es necesario tener claro qué periféricos 
y qué características de los mismos se van a necesitar 
o En este caso sólo va a ser el LCD 
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1. Cuando ya tenemos claro qué recursos se van a necesitar en el 
Proyecto, se arranca el STM32CubeMX. 

2. Se selecciona ACCESS TO BOARD SELECTOR. 

3. Se selecciona la STM32L-DISCOVERY. 

4. Se pulsa Start Project. 

5. Y se indica “Yes” para inicializar los periféricos en modo por 
defecto (hasta aquí ya los has hecho hasta la transparencia 55).  

6. Esto arranca la pantalla de configuración de pines y periféricos 
1. En el árbol se secciona Multimedia 
2. Se pincha en LCD 
3. En la vista de detalles, en la parte superior, se indica que el LCD se usará 

en Modo 1/4 Duty Cycle 
4. Y ahora se modifican los parámetros de configuración según se indica en 

la transparencia siguiente  
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(C) Raúl Sánchez Reíllo 67 

• Clock Divider = 31 

• Bias Selector = 1/3 

• Pulse ON Duration = 
4/CK_PS 

• Blink Frequency = fLCD/32 

Dejad estos pines tal 
y como el sistema 

los ponga por 
defecto 
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7. Selecciona ahora la pestaña “Clock Configuration” y se asegúrate 
que está configurado como se ha comentado anteriormente 
o HSI seleccionado, y el resto de parámetros necesarios para tener reloj de 

32MHz 

8. Selecciona la pestaña “Project Manager”: 
o En la sub-pestaña “Project” (transparencia 66): 

1. Se le da un nombre al proyecto (por ejemplo, Tema5_Ej1) 

2. Se selecciona la carpeta de la asignatura (por ejemplo, D:\SDBM\) 

3. “Application Structure” se deja en “Basic” 

4. “Toolchain / IDE” se selecciona como “MDK-ARM V5” 

o En la sub-pestaña “Code Generator” (transparencia 67): 
1. Se activa la opción “Copy only the necessary library files” 

9. Ahora se pulsa “GENERATE CODE” 

10. Para finalizar, se pulsa “Open Project” (transparencia 68) 
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• Con esto se crea y se abre el uVision, los siguientes pasos a realizar 
son los siguientes (todos estos pasos se comentan en las siguientes 
tranparencias): 

1. Abrir las Opciones del Target. 

2. Añadir a la ruta de compilación de C/C++ la ubicación de la biblioteca 
STM32L152C-Discovery (la que se copió en el raíz de la carpeta de la 
asignatura en la transparencia 60). 

3. Configurar las herramientas de depuración. 

4. Configurar las utilidades del entorno. 

5. Añadir la Biblioteca de la Discovery. 

6. Escribir el Programa de la Solución. 

7. Compilar y Probar la solución. 

• Posteriormente se explicará como depurar la solución. 
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• Al abrirse el uVision, verás la siguiente estructura ya creada. 
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• Abre el menú emergente del proyecto y elije “Options for Target…”. 
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• Selecciona la pestaña “C/C++”, ajusta la opción “Level 0” en 
“Optimization “y pulsa en el botón “Include Paths”. 
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• Pulsa en el botón de “Add New” (al lado de la cruz roja). 
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• Selecciona la carpeta “STM32L152C-Discovery” que se creó en el 
raíz de la carpeta de la asignatura, la de la transparencia 60). 
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• IMPORTANTE: Selecciona el nivel de optimización a 0, y no actives 
la optimización por tiempo 
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• Selecciona la pestaña “Debug” y selecciona la opción de utilizar un 
depurador (la columna de la derecha), y selecciona “ST-Link Debugger” 
dentro de las opciones de depuradores.  

• Fíjate en las casillas que están activadas en la figura, puesto que es la 
configuración recomendada. 
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• Después de seleccionar el depurador (ST-Link Debugger), pulsa el botón “Settings”, para ver la configuración 
del mismo. 

• Selecciona “SW” como puerto. 

• Si se tiene conectada la placa (recomendado), entonces verás a la derecha los datos de la placa conectada 
(ver esta imagen). Si no, se verá una pantalla como la de la figura de la siguiente transparencia. 

• En cualquier caso, fíjate en las casillas seleccionadas y usa esta configuración 
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• Después de aceptar las opciones del depurador, selecciona la 
pestaña “Utilities” y copia la configuración que se muestra en la 
pantalla (deja todo por defecto según sale). 
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• Pulsa en el botón “Settings” (dentro de “Utilities”) y verifica que 
hay un mapa de memoria instalado (por ejemplo el expuesto en la 
figura). 

• También se recomienda que se seleccione “Erase Sectors”. 
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• El siguiente paso es añadir al proyecto la biblioteca de la Placa Discovery, 
para poder acceder a las funciones del LCD. 

• Para hacer eso, selecciona la opción “Add Existing Files to …” en la 
carpeta “Drivers/STML32”. 
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• Añade los dos ficheros .c que contiene la carpeta “STM32L152C-
Discovery” que se instaló en la carpeta de la asignatura en la 
transparencia 60. 
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• El resultado será que se añadirán los dos ficheros a la lista de 
ficheros de esa carpeta del árbol del proyecto. 

(C) Raúl Sánchez Reíllo SDBM - Tema 5: Entorno de Desarrollo 86 

CLASES PARTICULARES, TUTORÍAS TÉCNICAS ONLINE
LLAMA O ENVÍA WHATSAPP: 689 45 44 70

- - -
ONLINE PRIVATE LESSONS FOR SCIENCE STUDENTS
CALL OR WHATSAPP:689 45 44 70

www.cartagena99.com no se hace responsable de la información contenida en el presente documento en virtud al
Artículo 17.1 de la Ley de Servicios de la Sociedad de la Información y de Comercio Electrónico, de 11 de julio de 2002.
Si la información contenida en el documento es ilícita o lesiona bienes o derechos de un tercero háganoslo saber y será retirada.



http://dte.uc3m.es 

• Para facilitar el siguiente paso, compila el proyecto para crear en el 
árbol las relaciones entre los ficheros .c y los .h. 

• Para hacer eso, selecciona la opción “Project -> Rebuild all target 
files”. Si todo está correcto deberá salir abajo 0 errores. 
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• Selecciona el fichero “main.h” (que está dentro del fichero 
“mail.c”) para editarlo. 
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• En el fichero “main.h” localiza la línea: 
o /* Private includes ----------------------------------------------------------*/ 

o /* USER CODE BEGIN Includes */ 

• Y escribe después de esa línea las dos siguientes: 
o #include "stm32l152c_discovery.h" 

o #include "stm32l152c_discovery_glass_lcd.h" 

• Graba y cierra el fichero “main.h”. 

 

• Vuelve al fichero “main.c” y localiza la función: 
o int main(void) 

• Esta será la única función que vas a modificar en el fichero 
“main.c”, ya que el resto del código se hará en librerías, tal y como 
se le enseñará posteriormente. 
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• Todo programa de microcontrolador se basa en 2 partes fundamentales 
de la función main(): 
o Una parte de inicialización de los periféricos, las variables de la función “main”, 

las inicialización de las funciones del LCD, etc. 
 Se ejecutará una única vez al principio del programa. 

o Una parte de código metida dentro de un bucle infinito, que representará la 
funcionalidad continua deseada. 

• Por lo tanto tu trabajo constará en escribir dos partes de código: 
o Una de inicialización: 

 Se escribirá en la función main(), entre las líneas 
─ /* USER CODE BEGIN 2 */ 

 

─ /* USER CODE END 2 */ 

o Una de funcionamiento cíclico del programa: 
 Se escribirá en la función main(), entre las líneas 

─ /* USER CODE BEGIN WHILE */ 

     while(1)  

     { 

 

     } 

─ /* USER CODE END WHILE */ 
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• La inicialización para el LCD en este ejemplo es la siguiente 
(escríbela en el archivo): 
/* USER CODE BEGIN 2 */ 

BSP_LCD_GLASS_Init(); 

BSP_LCD_GLASS_BarLevelConfig(0); 

BSP_LCD_GLASS_Clear(); 

 /* USER CODE END 2 */ 
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• La ejecución cíclica para este ejemplo es la siguiente (escríbela en el archivo): 
/* USER CODE BEGIN WHILE */ 

while (1) 

{ 

  BSP_LCD_GLASS_Clear(); 

  BSP_LCD_GLASS_DisplayString((uint8_t *)"UNO"); 

  espera(5000000); 

  BSP_LCD_GLASS_Clear(); 

  BSP_LCD_GLASS_DisplayString((uint8_t *)"DOS"); 

  espera(5000000); 

  BSP_LCD_GLASS_Clear(); 

  BSP_LCD_GLASS_DisplayString((uint8_t *)"TRES"); 

  espera(5000000); 

  BSP_LCD_GLASS_Clear(); 

  BSP_LCD_GLASS_DisplayString((uint8_t *)"MAMBO"); 

  espera(5000000); 

  /* USER CODE END WHILE */ 

 

  /* USER CODE BEGIN 3 */ 

} 

/* USER CODE END 3 */ 
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• Como se puede ver en el código, hay una función que no está definida: espera() 
o Esa función será de utilidad en varios proyectos futuros, por lo que se va a crear una biblioteca 

de funciones propias. 

• Los siguientes pasos muestran cómo hacerlo, pero no se mostrará el código puesto 
que es un ejercicio propuesto. 

• Empezamos creando un fichero fuente, para lo que seleccionamos “File -> New…”. 
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• Una vez escrito el código (en el que no está resaltada la sintaxis por no 
saber el entorno que tipo de fichero es), hay que guardar el fichero con la 
opción “File -> Save”.  

• Cuidado: lo que ves en la imagen no es el código se la librería espera(), 
ese lo tienes que pensar tú. 
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• Pónle un nombre con la extensión adecuada al formato (por ejemplo, si es un 
fichero en C, pónle un nombre acabado con .c; si es un fichero “header” de C, 
pónle un nombre acabado con .h) 

• Al almacenarlo con un nombre y extensión, ya será posible que el entorno 
resalte la sintaxis con colores. 

• El nombre del fichero puede ser cualquiera, pero se aconseja que sea un nombre 
representativo (por ejemplo, Utils_SDBM.c y Utils_SDBM.h). 
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• Sin embargo, todavía este fichero no está en el proyecto, por lo que 
habrá que decirle al proyecto la necesidad de incorporarlo al mismo. 

• Para ello pulsa el botón derecho en “Application/User”, selecciona la 
opción “Add Existing Files to Group …” y mete sólo el archivo .C. 
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• Se puede ver el fichero integrado ahora en el proyecto, pero hay 
que añadir el .h en el código del proyecto. 

• Añade el .h en un #include dentro del código del fichro “main.c”. 
o Localiza la línea #include main.h 

o Después de esa línea incluye la siguiente (cuidado: el nombre del fichero 
debe ser el que hayas dado al tuyo, y ten cuidado con la localización relativa 
al proyecto): 
 #include "..\..\Utils_SDM.h“ 
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• El proyecto ya está listo para compilar. 

• Selecciona la opción “Project -> Rebuild all target files”. 
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• Durante la compilación verá aparecer mensajes en la ventana 
inferior del programa, y finalmente un mensaje diciendo el número 
de errores y avisos (warnings) resultantes. 

• Una vez conseguido 0 errores, está listo para ejecutar el proyecto. 
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9 - Pasos para la depuración de un proyecto 
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• Una vez compilado correctamente, conecta la placa al puerto USB (si no estaba 
ya) y ejecuta el depurador con el botón         : 
o Tardará bastante hasta que cargue y luego aparecerá un aviso del modo de evaluación. 

Pulsa “Aceptar”. 

• Si se abre una ventana con ensamblador, pulsa       para cerrarla. 

• Como se puede ver, el programa se ha ejecutado hasta llegar a la función main(). 
La flecha amarilla indica el punto del programa donde se encuentra la ejecución. 
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• Para depurar, se pueden utilizar las siguientes opciones: 
o 1) Ejecutar de corrido todo el programa desde el punto actual. Si hay puntos 

de ruptura, se para en ese punto: 

o 2) Se depura la función actual, pero sin entrar en ella: 

o 3) Se ejecuta todo el programa hasta el punto donde actualmente se 
encuentra el cursor: 

o 4) Se depura la función actual, entrando en ella, si es necesario: 

o 5) Se sale de la función actual (se ejecuta lo que queda de función y se 
pausa la ejecución al finalizarla). Solo funciona cuando se ha activado la 
anterior previamente: 

• Además se puede poner un punto de ruptura (breakpoint), es decir 
pausar la ejecución cuando se llega a ese punto), haciendo doble 
clic en cualquier punto a la izquierda del número de línea. 
o Aparecerá un círculo en rojo. 

o Si se vuelve a hacer doble clic, se quita el breakpoint. 
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• Para examinar el valor de una variable, abra una Watch Window 
(View -> Watch Windows-> Watch 1) 
o En la parte inferior derecha, junto con “Call Stack” y con “Memory 1” se 

abre una nueva pestaña denominada “Watch 1”. 
o En dicha pestaña, escribe el nombre de la variable, registro o conjunto de 

registros. 
 Por ejemplo, escriba RCC y verá una estructura completa con los registros del 

reloj. 

o En cada variable se puede ver su valor (sólo si se entra en la función donde 
se ejecuta) o incluso modificarlo para que sea tenido en cuenta en el 
siguiente paso de ejecución. 

• Para ver los registros asociados a los periféricos o modificar su 
valor, selecciona la opción “Peripherals ->System Viewer” y ahora 
haz visible el registro deseado (por ejemplo: GPIO -> GPIOB) 
o Por ejemplo, activa el LED verde y rojo en PB6 y PB7, activando los bits BS6 y 

BS7 del registro BSRR en GPIOB, o desactívelos activando los bits BR6 y BR7 
de dicho registro (cuando el depurador esté dentro de la función WHILE(1)).  
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10- Peculiaridades de la Programación 
en C en Microcontroladores 
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• El Lenguaje C utilizado es ANSI-C, es decir, no tiene de por sí, 
ninguna variación a cualquier otra plataforma. 

• Sin embargo sí que es necesario mantener unas determinadas 
prácticas adicionales, para hacer una programación satisfactoria. 

• La razón es que NO estamos programando una aplicación en un PC, 
donde los recursos se podrían considerar limitados. 
o Aquí se plantea una arquitectura con UNOS RECURSOS MUY LIMITADOS, 

tanto en cantidad de memoria, como en potencia de cálculo. 

o Además se trata de una arquitectura que no tiene por qué tener un teclado, 
una pantalla o una conexión a internet, por lo que el desarrollador tiene que 
tener muy presente la arquitectura con la que trabaja. 

• En las siguientes transparencias se ilustran algunas 
recomendaciones. 
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• Usa el tamaño de variable que más se ajuste a tus necesidades. 
o Si una variable va a tener solo valores entre el 0 y el 5, usa un unsigned 
char, en lugar de un int (se pasa de usar 1 byte a 4 bytes). 

o Si la variable no va a tener valores negativos, usa unsigned, para limitar los 
valores (y evitar problemas de cálculo posteriores). 

• Salvo que sea estrictamente necesario, no utilice asignación dinámica de 
memoria, sino estática. 
o La asignación dinámica de memoria implica: 

 Utilización de métodos adicionales como malloc() que consumen tiempo y 
recursos. 

 Que cada trozo de memoria asignado, debe tener también espacio de reserva para 
los punteros de asignación (cada puntero son 4 bytes). 

 Que la programación tenga que ser más cuidadosa para no desbordar la memoria o 
acceder a partes reservadas de la memoria. 

─ En concreto, un control bastante elevado del uso de punteros. 

o Por ejemplo, si se va a usar una variable para el mensaje del LCD, y se sabe que 
dicho mensaje es como mucho de 6 caracteres, usa: 
 unsigned char message[6]; 

 Y accede de forma estática al tercer carácter con message[2]; 
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• No utilices funciones externas de las que desconozcas su verdadero 
funcionamiento, o que estén sobredimensionadas a sus necesidades. 
o Por ejemplo, se suele cometer el error de pensar que printf(message) va a 

mostrar el contenido de message por pantalla pero: 

 ¿Seguro que se va a mandar por pantalla? 

─ No, se va a mandar por un puerto serie. 

 ¿Cuanta memoria ocupa utilizar printf()? 

─ Muchísima más que la necesaria, ya que no sólo es el envío de caracteres, sino que 
también contiene la forma de formatear la cadena message (por ejemplo los parámetros 
%). 

• Pasa los parámetros complejos por referencia, en lugar de por valor. 
o Al pasar los parámetros por referencia, sólo se copia el puntero al dato, pero el 

dato no se duplica en la función.  

o Sin embargo, al pasarlo por valor, el contenido del parámetro se copia como una 
nueva variable en la ejecución de la función. 

o Por defecto, el lenguaje C pasa todos los parámetros complejos por referencia, 
pero una mala programación puede forzar a pasarlos por valor. 
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• Utiliza siempre variables locales. 
o De esta forma, cuando se salga de la función, se destruye la variable y se libera 

la memoria. 
o Si crea una variable compleja dentro de una función, acuérdate de eliminarla 

coherentemente antes de salir de la función. 

• No utilices cálculos de excesivo coste, cuando no es necesario. En 
concreto, intenta evitar cálculos con decimales. 
o La aritmética del microcontrolador es una aritmética entera, por lo que 

cualquier cálculo decimal supondría el tener que incluir en el código las rutinas 
correspondientes para hacer el cálculo en punto fijo o en punto flotante a partir 
de la ALU entera. 
 Esto conlleva un aumento enorme del tamaño del programa, así como de su tiempo 

de computación. 
o Por ejemplo, si en un problema va a trabajar con temperaturas, con precisión de 

un decimal, entre -20 y +50 grados, no trabajes con decimales, sino considera 
trabajar con enteros entre -200 y +500, que en este caso cabrían en una variable 
de tipo short. 

• También recuerda que si usa aritmética entera x/y = 0 siempre que x sea 
menor que y, por lo que debería multiplicar x por algún valor antes de 
dividir. 
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• Si hay parámetros que pueden llegar a cambiar de proyecto a 
proyecto, utiliza #define: 
o Los #define se ubican normalmente en la parte inicial de un fichero .c, o en 

los ficheros .h. 

o Al cambiar el valor, automáticamente se cambia en todos los sitios donde se 
haya utilizado el identificador utilizado en el #define. 

o Además el cambio se hace en momento de compilación, por lo que no 
implica un coste computacional. 

o Por ejemplo: 
#define MAXIMO 500; 

… 

If (valor > MAXIMO) Error(); 

Else Procesa(valor); 

… 

Porcentaje = valor*100/MAXIMO; 
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• Los registros ya se encuentran definidos en: 
o stm32l152xb.h 

• Esta biblioteca ya se encuentra incluida en los proyectos, por lo que 
no hay que hacer nada adicional para usarla. 
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11 - Recomendaciones de Uso de la Placa 
de Desarrollo 
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• Para poder utilizar mucho mejor la placa STM32L1-Discovery, es 
aconsejable: 
o Pincharla en una protoboard (o en un conjunto de ellas), de forma que los 

pines no se cortocircuiten y además dejen huecos para conectar los cables. 

o Meter el conjunto de la protoboard (la placa y las conexiones realizadas) en 
una caja para su transporte y así evitar que se suelten las conexiones. 

• En la siguiente transparencia se puede ver el detalle de conexión, 
así como un ejemplo de uso. 
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12 - Ejercicios 
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1. Crea la función espera(int ciclos) que permita, mediante el 
parámetro ciclos, esperar un determinado tiempo 
correspondiente al número de ciclos. Utiliza para ello un bucle 
for(intenta ajustar el número de ciclos del bucle for para que 
cada espera sea de 1 segundo). Para ello, ten en cuenta: 

1. Que cada instrucción en ensamblador se ejecuta en un único ciclo de reloj. 

2. Que cada instrucción en C son varias instrucciones en ensamblador. 

3. Que el reloj está funcionando a 32MHz. 

2. Crea el proyecto ejemplo del LCD explicado a lo largo de todo 
este tema, compílalo, depúralo y comprueba que funciona como 
se ha explicado en la transparencia 62. 
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